APMS 3.0 Flight Analyst Guide

Revision 0.5.1

Griff Jay, Gary Prothero, Timothy Romanowski, Robert Lynch, Robert Lawrence, and Loren Rosenthal
Ames Research Center, Moffett Field, California

October 2004
Since its founding, NASA has been dedicated to the advancement of aeronautics and space science. The NASA Scientific and Technical Information (STI) Program Office plays a key part in helping NASA maintain this important role.

The NASA STI Program Office is operated by Langley Research Center, the lead center for NASA's scientific and technical information. The NASA STI Program Office provides access to the NASA STI Database, the largest collection of aeronautical and space science STI in the world. The Program Office is also NASA's institutional mechanism for disseminating the results of its research and development activities. These results are published by NASA in the NASA STI Report Series, which includes the following report types:

- **TECHNICAL PUBLICATION.** Reports of completed research or a major significant phase of research that present the results of NASA programs and include extensive data or theoretical analysis. Includes compilations of significant scientific and technical data and information deemed to be of continuing reference value. NASA counterpart of peer-reviewed formal professional papers, but having less stringent limitations on manuscript length and extent of graphic presentations.

- **TECHNICAL MEMORANDUM.** Scientific and technical findings that are preliminary or of specialized interest, e.g., quick release reports, working papers, and bibliographies that contain minimal annotation. Does not contain extensive analysis.

- **CONTRACTOR REPORT.** Scientific and technical findings by NASA-sponsored contractors and grantees.

- **CONFERENCE PUBLICATION.** Collected papers from scientific and technical conferences, symposia, seminars, or other meetings sponsored or co-sponsored by NASA.

- **SPECIAL PUBLICATION.** Scientific, technical, or historical information from NASA programs, projects, and missions, often concerned with subjects having substantial public interest.

- **TECHNICAL TRANSLATION.** English-language translations of foreign scientific and technical material pertinent to NASA’s mission.

Specialized services that complement the STI Program Office's diverse offerings include creating custom thesauri, building customized databases, organizing and publishing research results ... even providing videos.

For more information about the NASA STI Program Office, see the following:

- E-mail your question via the Internet to help@sti.nasa.gov
- Fax your question to the NASA STI Help Desk at (301) 621-0134
- Telephone the NASA STI Help Desk at (301) 621-0390
- Write to: NASA STI Help Desk NASA Center for AeroSpace Information 7121 Stanford Drive Hanover, MD 21076-1320
APMS 3.0 Flight Analyst Guide

Revision: 0.5.1

Available from:

NASA Center for AeroSpace Information
7121 Standard Drive
Hanover, MD 21076-1320
301-621-0390

National Technical Information Service
5285 Port Royal Road
Springfield, VA 22161
703-605-6000

This report is also available in electronic form at
http://humanfactors.arc.nasa.gov/web/library/publications/publications.php
Contents

1. Introduction ......................................................................................................................... 1
   1.1. APMS Overview .............................................................................................................. 1
       1.1.1. Flight Data Importation ............................................................................................. 1
       1.1.2. Flight Data Analysis ................................................................................................. 1
   1.2. Document Scope .............................................................................................................. 2
   1.3. Document Styles .............................................................................................................. 3

2. Getting Started ...................................................................................................................... 5
   2.1. Start Application ............................................................................................................. 5
   2.2. Log In ............................................................................................................................ 5
   2.3. Select Tool ..................................................................................................................... 6

3. Morning Report ..................................................................................................................... 7
   3.1. Overview ......................................................................................................................... 7
   3.2. Details ............................................................................................................................. 7
       3.2.1. Select Analysis Report ............................................................................................... 7
       3.2.2. View Analysis Summary ............................................................................................ 9
       3.2.3. View Flight List ......................................................................................................... 10
       3.2.4. View Parameter Traces ............................................................................................. 11
       3.2.5. Other Options ........................................................................................................... 12
       3.2.6. Validate Atypicality ................................................................................................. 12

4. Data Exploration .................................................................................................................. 13
   4.1. Overview ......................................................................................................................... 13
   4.2. Details ............................................................................................................................. 13
       4.2.1. Select Flights ............................................................................................................ 13
       4.2.2. Quantify Routine Events ........................................................................................... 15
       4.2.3. View Events ............................................................................................................. 16
       4.2.4. Load FFD into Viewer ............................................................................................... 17
       4.2.5. View Parameter Values Grid .................................................................................... 18
       4.2.6. View Flight in GRADE ............................................................................................ 20

5. Viewer .................................................................................................................................. 21
   5.1. Overview ......................................................................................................................... 21
   5.2. Details ............................................................................................................................. 21
       5.2.1. Open FFD File ........................................................................................................... 21
       5.2.2. Add Parameters ........................................................................................................ 23
       5.2.3. Change Parameter Set ............................................................................................... 25
       5.2.4. Add Routine Event Markers ...................................................................................... 26
       5.2.5. Position Cursor Marker ............................................................................................ 27
       5.2.6. Set Timeline .............................................................................................................. 29
       5.2.7. Other Options ........................................................................................................... 32

6. Search Pattern (Simple Mode) .............................................................................................. 33
   6.1. Overview ......................................................................................................................... 33
   6.2. Details ............................................................................................................................. 33
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.2.1.</td>
<td>Create New Pattern</td>
<td>33</td>
</tr>
<tr>
<td>6.2.2.</td>
<td>Create New Module</td>
<td>36</td>
</tr>
<tr>
<td>6.2.3.</td>
<td>Run New Pattern Query</td>
<td>46</td>
</tr>
<tr>
<td>6.2.4.</td>
<td>Open Existing Pattern Query</td>
<td>49</td>
</tr>
<tr>
<td>6.2.5.</td>
<td>Interpret Pattern Results</td>
<td>50</td>
</tr>
<tr>
<td>7.1.</td>
<td>Overview</td>
<td>53</td>
</tr>
<tr>
<td>7.2.</td>
<td>Details</td>
<td>54</td>
</tr>
<tr>
<td>7.2.1.</td>
<td>Create Page Group</td>
<td>54</td>
</tr>
<tr>
<td>7.2.2.</td>
<td>Add Page to Page Group</td>
<td>56</td>
</tr>
<tr>
<td>7.2.3.</td>
<td>Add Chart to Page</td>
<td>58</td>
</tr>
<tr>
<td>7.2.4.</td>
<td>Create Query</td>
<td>60</td>
</tr>
<tr>
<td>7.2.5.</td>
<td>Run Report</td>
<td>64</td>
</tr>
<tr>
<td>7.2.6.</td>
<td>View Charts</td>
<td>67</td>
</tr>
<tr>
<td>8.1.</td>
<td>Overview</td>
<td>69</td>
</tr>
<tr>
<td>8.2.</td>
<td>Details</td>
<td>69</td>
</tr>
<tr>
<td>8.2.1.</td>
<td>Select Fleet</td>
<td>69</td>
</tr>
<tr>
<td>8.2.2.</td>
<td>View Flight List</td>
<td>70</td>
</tr>
<tr>
<td>8.2.3.</td>
<td>Filter Flight List</td>
<td>71</td>
</tr>
<tr>
<td>8.2.4.</td>
<td>Select Flight</td>
<td>72</td>
</tr>
<tr>
<td>8.2.5.</td>
<td>View Special Events &amp; Routine Events</td>
<td>73</td>
</tr>
<tr>
<td>8.2.6.</td>
<td>View Analysis List &amp; Analysis Details</td>
<td>74</td>
</tr>
<tr>
<td>8.2.7.</td>
<td>Validate Selection</td>
<td>75</td>
</tr>
<tr>
<td>9.1.</td>
<td>Overview</td>
<td>79</td>
</tr>
<tr>
<td>9.2.</td>
<td>Set-up Details</td>
<td>80</td>
</tr>
<tr>
<td>9.2.1.</td>
<td>Log In</td>
<td>80</td>
</tr>
<tr>
<td>9.2.2.</td>
<td>Create User Category</td>
<td>81</td>
</tr>
<tr>
<td>9.3.</td>
<td>Performance Report Details</td>
<td>83</td>
</tr>
<tr>
<td>9.3.1.</td>
<td>Create New Template</td>
<td>83</td>
</tr>
<tr>
<td>9.3.2.</td>
<td>Create New Report</td>
<td>85</td>
</tr>
<tr>
<td>9.3.3.</td>
<td>View Report</td>
<td>87</td>
</tr>
<tr>
<td>9.4.</td>
<td>Special Event Report Details</td>
<td>90</td>
</tr>
<tr>
<td>9.4.1.</td>
<td>Create New Template</td>
<td>90</td>
</tr>
<tr>
<td>9.4.2.</td>
<td>Create New Report</td>
<td>93</td>
</tr>
<tr>
<td>9.4.3.</td>
<td>View Report</td>
<td>95</td>
</tr>
<tr>
<td>10.</td>
<td>Glossary</td>
<td>98</td>
</tr>
</tbody>
</table>
1. Introduction

1.1. APMS Overview

The Aviation Performance Measuring System (APMS) is a method—embodied in software—that uses mathematical algorithms and related procedures to analyze digital flight data extracted from aircraft flight data recorders.

APMS consists of an integrated set of tools used to perform two primary functions:

- Flight Data Importation
- Flight Data Analysis

These functions are described below.

1.1.1. Flight Data Importation

Air carriers store digital flight data on a variety of media including optical disks and electronic memory devices. These data are regularly downloaded and processed with the use of commercial flight data processing software. This commercial software converts the data from their native storage units into standard engineering units. It also identifies exceedance events in the data and generates standard reports and statistics characterizing the data. The results of this processing activity are stored in online data stores of varying formats. All of this activity by commercial flight data processing software occurs prior to data importation by APMS.

On a regular basis, APMS data importation tools are used to access the online data stores created by the commercial flight data processing software. These tools locate new flight data and perform various filtering, structuring, signature extraction, compression, and storage processes.

APMS data importation tools include the Loader, Parameter Editor, Phase Editor, and Fleet Editor.

1.1.2. Flight Data Analysis

APMS includes tools that permit flight analysis to be performed by both computers and humans, since both are necessary to produce meaningful results. The following paragraphs describe how this is accomplished.

Computerized Analysis

The computerized analysis process is performed by the Analysis Engine. This tool examines the imported data to determine typical flight patterns and also identifies flights that do not conform well to any typical pattern. The Analysis Engine does this by using statistical, rather than operational, criteria. It ranks atypical flights in order of their degree of deviation from the norm. The system finds the specific flight phases that are atypical and identifies the flight parameters that contributed to the unusual performance. Since the Analysis Engine accomplishes these various functions without any
prior human specification of normal or operationally interesting flights, it can reveal unexpected
events or trends that could compromise the safety of flight operations.

**Human-Guided Analysis**

Atypical flights identified by the Analysis Engine are brought to the attention of airline safety
analysts, who use other APMS tools to determine whether these flights are of operational interest. The
*Morning Report* tool is a key component in the human-guided analysis of flight data. This tool
displays the output of the Analysis Engine. Because words can often convey more meaning than raw
statistics to air carrier analysts, the Morning Report provides textual descriptions of the atypical flights
identified by the Analysis Engine. The Morning Report also displays graphical representations of the
Analysis Engine’s findings in the form of *parameter traces* and *parameter clouds*. The latter depict
the range of variation commonly observed in the flight data. This graphical visualization provides a
frame of reference against which parameter traces from atypical flights can be displayed and visually
assessed by human analysts.

In addition to Morning Report, human-guided analysis tools include *Viewer, Data Exploration,
Search Pattern, Events Charts*, and *Reports*. Aviation safety analysts use the *Flight Validation* tool to
record their findings.

**1.2. Document Scope**

This document is written for aviation safety analysts who use APMS to analyze digital flight data.
It contains descriptions of the human-guided flight analysis tools available in APMS 3.0. Each of
these tools except the Viewer is directly accessible from the **APMS Main Toolbar** (see Figure 1.1).
The Viewer is accessible from within most of the other tools.

The following flight analysis tools are described in detail:

- Morning Report
- Data Exploration
- Viewer
- Search Pattern
- Event Charts
- Flight Validation
- Reports
The Utilities Toolbar (see Figure 1.2) provides access to several tools that are used primarily by systems administrators to configure APMS for data importation and to set up user permissions. The Utilities Toolbar also provides access to the Analysis Engine that is used to perform computer-driven flight analysis. For a description of the tools in the Utilities Toolbar, see the APMS 3.0 System Administrator's Guide.

1.3. Document Styles

- **Bold** text is used throughout this document to identify user interface features such as windows, buttons, and fields.
- *Italicized* text is used throughout this document to identify APMS-specific terms defined in the Glossary (see Section 0).
2. Getting Started

2.1. Start Application

Before using any of the APMS flight analysis tools, flight analysts must start the application and log in. To begin, click the APMS Shortcut icon (see Figure 2.1) on the computer desktop.

2.2. Log In

To log in, perform the following steps:

- Select the appropriate user name in the User drop-down list. 2.2a
- Enter the password in the Password text box. 2.2b
- Click Login. 2.2c
2.3. Select Tool

In the APMS Main Toolbar (see Figure 2.3), click the icon of any available flight analysis tool.
3. **Morning Report**

3.1. **Overview**

The Morning Report tool provides textual descriptions and graphical representations of data imported from *analysis reports*, which are generated by an APMS utility called the *Analysis Engine*. To understand the Morning Report tool, it is important to learn more about these analysis reports.

The Analysis Engine produces analysis reports by comparing data from newly imported flights with data from earlier, or baseline, flights. However, only the new flights are listed in the analysis report. New and existing flights from the same fleet (and, if applicable, from the same originating or destination airport) are grouped by *phase* to form a 1,000-flight *aggregation*. The computerized analysis determines typical flight patterns for the aggregation and also identifies phases in the new flights that do not conform well to any typical pattern. The Analysis Engine then ranks the atypical flights and phases in order of their degree of deviation from the norm. The system also identifies the flight *parameters* that contributed to the unusual performance.

The Morning Report tool allows analysts to view and investigate these *atypicalities*—flights or phases of flights containing parameter values that deviate from the group norm. Each atypical flight or flight phase is ranked from 1 (lowest degree of deviation) to 3 (highest). When a rank applies to a single flight phase (such as Takeoff or Landing), it is called a *phase atypicality* rank. When a rank applies to an entire flight (all combined phases), it is called a *global atypicality* rank.

It’s important to note that *Level 3 atypicalities* in the Morning Report do not necessarily point to safety or quality problems in the flights or phases in which they appear. Instead, atypicalities should be considered as starting points for further investigation of potential problems. Analysts must gather additional flight information (with the help of other tools in the APMS suite) to validate or invalidate atypicalities in the Morning Report. For example, an analyst might invalidate or exempt atypicalities resulting from bad data sensors or weather-related flight adjustments.

3.2. **Details**

3.2.1. Select Analysis Report

![Figure 3.1. Start Morning Report Window](image)

The *Start Morning Report* window (see Figure 3.1) provides access to the list of analysis reports.
To view the list of available reports, select Morning Report>Choose Morning Report in the menu.  

Figure 3.2. Morning Report Selector Window

The Morning Report Selector window (see Figure 3.2) contains a list of the available analysis reports. Note that the list includes the date that each report was generated by the Analysis Engine tool.

To view a specific report, select it and click View Morning Report.
3.2.2. View Analysis Summary

The **Morning Report Summary** window (see Figure 3.3) summarizes the global and phase atypicalities contained in the report. In this example, note that there are three Level 3 global atypicalities and four Level 3 phase atypicalities. Also note that Morning Report atypicality levels can be identified by the following colors:

- Red—Level 3 (most atypical)
- Yellow—Level 2
- Aqua—Level 1 (least atypical)

To view more details about the atypical flights and flight phases in the report, click **Go to Flight List**.
3.2.3. View Flight List

Figure 3.4. Morning Report Flight List Window

The Morning Report Flight List window (see Figure 3.4) lists the flights and phases with atypicalities. The Flight column contains a flight’s unique FFD (Full Flight Data) or SFFD (Scrubbed Full Flight Data) number. This is the number that the APMS system uses to track different flights. This window also lists the processing date, phase, airport origin, airport destination, validation status, and significant parameters of every flight. Note that a flight’s global atypicality rank appears in the Level column and the phase atypicality rank appears in the Phase column. Flights that contain more than one phase atypicality are preceded with a symbol. To view other atypical phases in the flight, simply click in any column of the line.

To view the parameter traces of an atypical phase, select the appropriate line and then click Explore Flight.

Note: Atypicalities are computed by phase with other flights in an aggregation, a group of new and existing flights (typically totaling 1,000) used by the Analysis Engine to produce an analysis report. Low-elevation flight phases (Taxi-out, Takeoff, Low Speed Climb, Low Speed Descent, Final Approach, Landing, and Taxi-in) are aggregated by phase, fleet, and airport. High-elevation flight phases (High Speed Climb, Cruise, and High Speed Descent) are aggregated by phase and fleet only.
3.2.4. View Parameter Traces

The Morning Report Atypicality Analysis window (see Figure 3.5), displays a flight’s parameter trace relative to the combined parameter traces of other flights in the aggregation. In the example above, the black line represents the flight’s data trace for the selected parameter. The shaded area, or parameter cloud, represents the combined parameter traces of other flights in the aggregation. When the cursor is positioned inside the parameter cloud, an information box will identify the percentage of flights that contributed to that data region. Click Typical to view the combined traces of the most typical flights (representing 80 percent of the total). Click All to view the combined traces of all flights in the aggregation.

The Rationale List box identifies the most significant characteristic for every parameter that contributed to the flight’s phase atypicality ranking.

The Morning Report Atypicality Analysis window (see Figure 3.5), displays a flight’s parameter trace relative to the combined parameter traces of other flights in the aggregation. In the example above, the black line represents the flight’s data trace for the selected parameter. The shaded area, or parameter cloud, represents the combined parameter traces of other flights in the aggregation. When the cursor is positioned inside the parameter cloud, an information box will identify the percentage of flights that contributed to that data region. Click Typical to view the combined traces of the most typical flights (representing 80 percent of the total). Click All to view the combined traces of all flights in the aggregation.

The Rationale List box identifies the most significant characteristic for every parameter that contributed to the flight’s phase atypicality ranking.
3.2.5. Other Options

The analyst can obtain additional flight information by clicking one of the following:

- The Flight Info button links to a table containing the flight’s numerical parameter values.
- The APMS Viewer button allows the analyst to view all significant parameter traces on a single graph.

3.2.6. Validate Atypicality

The analyst can validate an atypicality by clicking one of the following:

- The Flight Validation button launches the Flight Validation tool (described in Section 7.1 of this document). This tool allows the analyst to view and validate all phase atypicalities for the flight. It also allows the analyst to view and validate any special events (also known as exceedances) that may have occurred during the flight.
- The Quick Validation button allows the analyst to bypass the Flight Validation tool to validate an atypicality quickly.
4. Data Exploration

4.1. Overview

The Data Exploration tool allows analysts to conduct in-depth research on a flight. This tool puts several other tools and utilities within easy reach, including the Viewer, Parameter Editor, and Loader.

4.2. Details

4.2.1. Select Flights

To select a group of flights in a fleet, select Edit>Select Flights in the menu of the Data Exploration window (see Figure 4.1).

Note: To select only a single flight by its FFD or SFFD identification number, select File>Open FFD and navigate to the appropriate file.
In the Select Flights window (see Figure 4.2), perform the following steps:

- Select the appropriate fleet in the Fleet list box.
- Select the beginning month and year of the query in the Begin Date drop-down lists.
- Select the ending month and year of the query in the End Date drop-down lists.
- Select the appropriate tail number(s) in the Available Tail Numbers list. Note: To select multiple tail numbers, hold down the CTRL key and click the desired items. To quickly select a contiguous block of tail numbers, hold down the SHIFT key and click the first and last items in the block.
- Select flight origin(s) in the Origin list box. Note: To select multiple origins, hold down the CTRL key and click the desired items.
- Select flight destination(s) in the Destination list box. Note: To select multiple destinations, hold down the CTRL key and click the desired items.
- To include only those flights that departed one of the selected origin airports and also arrived at one of the selected destination airports during a single flight, check the **Flight Origin and Destination Airports Must Match Selection** box.

**Note:** If this box is not checked, origin and destination will be uncoupled. In other words, the query will include all flights leaving the origin airport(s), regardless of destination. It also will include all flights arriving at the destination airport(s), regardless of origin.

- When finished, click **OK**.

4.2.2. **Quantify Routine Events**

The **Data Exploration** window (see Figure 4.3) displays summary information about all of the flights that match the flight selection criteria.

The Data Exploration tool now provides many analysis options for conducting additional research. Before choosing an analysis option, first select a single flight.
To quantify the routine events for a specific flight, select Edit>Validate Data in the menu of the Data Exploration window (see Figure 4.4).

In the Data Exploration window (see Figure 4.5), notice that the Problem Description column now appears. This column lists the number of routine events identified in the flight. Bad or missing data will result in flights with fewer identified routine events.

### 4.2.3. View Events

To view a list of all routine events and special events associated with a flight, select Events>All Events in the menu of the Data Exploration window (see Figure 4.6).
The **Flight Information** window (see Figure 4.7) provides summary information, *phases*, special events, routine events, and weather associated with the flight. The analyst also can use this window to access the *Viewer* or to obtain flight information from other FFDs or SFFDs.

### 4.2.4. Load FFD into Viewer

To load a flight in the Viewer, select *Viewer>*Load FFD into Viewer* in the menu of the *Data Exploration* window (see Figure 4.8).
The Viewer window (see Figure 4.9) now displays a graphical representation of parameter values recorded during the selected flight. For a complete description of the Viewer, see Section 0.

4.2.5. View Parameter Values Grid

Figure 4.10. Data Exploration Window
To view a table containing the flight's parameter values, select **Grid→Go to Grid** in the menu of the **Data Exploration** window (see Figure 4.10).

**Figure 4.11. Flight Data Table**

The **Flight Data Table** (see Figure 4.11) lists the value or values for every parameter in a given parameter set. To change the parameter set, simply make a new selection in the parameter set dropdown list **4.11a**, and then click **Go**. **4.11b**
4.2.6. View Flight in GRADE

Figure 4.12. Data Exploration Window

To view a flight in the Graphical Airspace Design Environment (GRADE), select **Grade>Go to Grade** in the menu of the Data Exploration window (see Figure 4.12). GRADE, developed by ATAC Corp., is a PC-based, four-dimensional computer tool for displaying, analyzing, designing, and evaluating air traffic operations.
5. Viewer

5.1. Overview

The Viewer is a powerful tool that allows analysts to study the interactions between significant parameters for any flight at any given time during the flight. The Viewer can be accessed only from other APMS tools, including Morning Report, Data Exploration, and Flight Validation.

The Viewer produces a graphical representation of multiple parameter values in a single window. These parameter traces share a common timeline. The Viewer can display parameter traces for any parameter recorded in a flight’s FFD (Full Flight Data) or SFFD (Scrubbed Full Flight Data) file. The Viewer also can display a flight’s routine events (regular flight occurrences such as Gear Up Takeoff and Flaps Down Approach).

Analysts use the Viewer as an analytical tool to help validate or invalidate atypicalities displayed in the Morning Report tool.

5.2. Details

5.2.1. Open FFD File

As mentioned above, the Viewer can be accessed only from other APMS tools. When initially opened, the Viewer window displays the FFD or SFFD file that has been selected by the active tool.

Once the Viewer window has been opened, it can be used to open directly any other available FFD or SFFD file. To open an FFD or SFFD file in the Viewer window, select File>Open FFD File in the menu and then navigate to the directory containing the appropriate file.
The **Viewer** window (see Figure 5.2) now displays a graphical representation of parameter values recorded during the selected flight. Notice that the window contains the following items:

- A parameter box on the left-hand side that contains a color-coded list of the charted flight parameters and their numerical parameter values at the position of the cursor.  
- A large graph area containing separate, color-coded traces of each flight parameter, displayed horizontally.
- Routine event markers that vertically intersect the parameter traces at various intervals.
- A combined events locator & timeline scroll bar at the bottom of the window.
5.2.2. Add Parameters

Analysts can easily add new parameters to the graph area. To begin, simply right-click inside the parameter box and select Add Parameter.
In the Select New Parameters window (see Figure 5.4), select a parameter in the Generic Name list, and then click OK.

*Note:* To select multiple parameters, hold down the CTRL key and click the desired items. To quickly select a contiguous block of parameters, hold down the SHIFT key and click the first and last items in the block.
5.2.3. Change Parameter Set

Analysts can easily change the active parameter set. Simply select any available set in the parameter set drop-down list.

Figure 5.5. Viewer Window (Partial View)

Analysts can easily change the active parameter set. Simply select any available set in the parameter set drop-down list.
5.2.4. Add Routine Event Markers

Analysts also can add routine event markers to the graph area. Simply click the left panel of the events locator bar to display a list of all routine events (see Figure 5.6). The checked items indicate routine events with active markers. Click items in the list to add new routine event markers.

Figure 5.6. Viewer Window (Partial View)
5.2.5. Position Cursor Marker

Analysts can click anywhere inside the graph area to produce a moveable cursor marker. The Time at Cursor from Liftoff and Time at Cursor to Touchdown display boxes at the top of the Viewer window (see Figure 5.7) indicate the position of the cursor marker relative to the time of liftoff and touchdown. The In View display box indicates the number of hours and minutes of flight data currently visible in the graph area. In the example above, the display boxes indicate that the cursor marker is at the liftoff position—exactly 4 hours, 5 minutes, and 8 seconds from touchdown—and that the entire flight is being displayed in the graph area.
To reposition the cursor, click and hold while dragging it to a new position. In Figure 5.8, note that the cursor marker is now positioned 40 minutes from touchdown and near to the End Cruise (CruE) routine event marker. Also note that numerical values in the parameter list box have changed for all parameters to reflect their values at this new cursor position.
To position the cursor over a routine event marker, simply click the appropriate event flag in the events locator at the bottom of the window. In Figure 5.9, note that the cursor marker now is positioned directly over the End Cruise (CruE) routine event marker and that the cursor marker now is displayed as a white line.

5.2.6. Set Timeline

Figure 5.10. Viewer Window (Partial View)
Analysts can zoom in on a portion of the flight by using the timeline scroll bar at the bottom of the window (see Figure 5.10). For example, to zoom in on the End Cruise portion of the flight, click and hold on the left scroll handle, and then drag the scroll handle to the right. Note that the time in the **Time from Liftoff to Left Scroll Handle** display box changes to reflect the new position of the left scroll handle.

**Figure 5.11. Viewer Window**

In Figure 5.11, note that the **In View** display box now indicates that only 34 minutes and 20 seconds of flight data are visible in the graph area. Also note that this same amount of time (34 minutes and 20 seconds) is represented by the space between the left scroll handle and the right scroll handle.
Analysts can preselect a time slice for viewing data. This is done by manipulating the distance between the scroll handles. In Figure 5.12, note that the In View display box reveals that the distance between the left scroll handle and the right scroll handle represents exactly 5 minutes. Now that the time slice has been set, analysts can use the following two methods to view data:

- Sliding: Click and hold on the space between the scroll handles, then drag the scroll bar to the appropriate event or location.
- Event centering: Click on the appropriate event flag in the events locator at the bottom of the window to center on that event.
5.2.7. Other Options

Other options available in the Viewer include the following:

- **PowerPoint**: Click this button to automatically load the current Viewer window into a PowerPoint presentation.
- **Reset View**: Click this button to reset the Viewer window to the default settings.
- **Show Grid**: Click this button to generate a flight data table containing all of the parameter values for the flight.
- **Grade>View Flight in Grade**: Select this menu option to launch the Graphical Airspace Design Environment (GRADE). GRADE, developed by ATAC Corp., is a PC-based, four-dimensional computer tool for displaying, analyzing, designing, and evaluating air traffic operations.
6. Search Pattern (Simple Mode)

6.1. Overview

The Search Pattern tool is used to search FFD or SFFD files for patterns in flight data. By identifying patterns associated with specific adverse events in a flight, analysts can better understand the causes of these events and, in turn, take actions to prevent them from occurring in the future.

Each pattern consists of one or more modules, or user-defined flight events. Each module is composed of at least one parameter condition, an equation that includes a specific flight parameter, an operator, and a numeric value (such as N1_Eng_1 ≤ 45). Each parameter condition in the module must be applied to an event frame, a selected period of time in a flight.

For example, to locate all flights that landed with an unstable approach, an analyst might want to create a pattern that contains one or more modules for flap position vs. airspeed, one module for high speed at landing, one module for low power on approach, and another module for excessive glide slope. Each module would be a piece of the pattern that defines an unstable approach. In this example, the module for high speed at landing would identify excessive airspeed parameters, (the parameter conditions) from the start of the final approach phase until touchdown (the event frame).

When an analyst runs a pattern, the Search Pattern tool queries the database and returns a list of flights that match any of the modules in the pattern. Analysts then can conduct additional research on the characteristics of matching flights or refine the pattern definition for future queries. Analysts also can make use of other APMS tools for further analysis.

6.2. Details

6.2.1. Create New Pattern

To begin a new pattern, select File>Pattern Management>Simple in the menu of the Search Pattern window (see Figure 6.1).

Note: The Search Pattern tool includes a simple mode and an advanced mode. This document describes only the simple mode.
The **Pattern Wizard** window (see Figure 6.2) lists all previously created patterns in the **Available Patterns** drop-down list. The **Available Modules** list box lists all previously created modules. It also lists routine events (when the **Include Routine Events** checkbox is selected).

**Note:** A pattern consists of one or more modules. A module is a user-defined flight event composed of one or more parameter conditions (such as N1_Eng_1_corr ≤ 45), applied to a specific time frame (such as Ten Minutes before Touchdown).

To create a pattern, select **New>Pattern** in the menu of the **Pattern Wizard Window** (see Figure 6.3).
In the **Editor** window (see Figure 6.4), enter a name for the new pattern in the text field and then click **OK**.

In the **Pattern Wizard** window (see Figure 6.5), select the new pattern in the **Available Patterns** drop-down list. Note that the new pattern is only an empty shell at this stage, as evidenced by the empty **Pattern Details** list box. In other words, the new pattern does not yet contain any pattern-defining modules.
Add Existing Modules to New Pattern

Figure 6.6. Pattern Wizard Window

To add existing modules to a new pattern, simply drag and drop items from the Available Modules list box to the Pattern Details list box in the Pattern Wizard window (see Figure 6.6).

To view the details (parameter conditions and event frame) associated with a particular module, simply click on an item in the Available Modules list box. The details will appear in the Module Description list box.

6.2.2. Create New Module

Figure 6.7. Pattern Wizard Window (Partial View)

To create a new module, select New>Module in the menu of the Pattern Wizard window (see Figure 6.7).
In the **Define New Module (Description) Window** (see Figure 6.8), perform the following steps:

- Type a name for the module in the **Name** field.  
- Type an abbreviation for the module in the **Abbreviation** field.  
- Specify the risk level in the **Risk Index** field.

**Note:** The Risk Index is an analyst-assigned risk level for each module in a pattern. This numerical value allows analysts to weight the relative degree of risk from the combined parameter conditions included in the module. A larger number indicates a greater risk. The Risk Index is used to compute the RIN for every flight that matches a pattern. Currently, there is no default Risk Index value range in APMS.

- When finished, click the >> button or the **When to Look** tab.
In the **Define New Module (When to Look)** window (see Figure 6.9), perform the following steps:

- Click a radio button for one of the following event frame categories:
  - **Defined Phases**: Contains only APMS-defined phases (such as Cruise).
  - **Defined Event Frames**: Contains all previously used event frames, including custom time periods created in the advanced mode of Search Pattern.
  - **User Defined**: Contains routine event markers (such as Taxi Out)

**Note**: An event frame is a selected moment or span of time in a flight. An event frame can be an APMS-defined phase (such as Cruise), a user-defined time period based on routine event markers (such as Taxi Out to Lift Off), or a custom time period created in the advanced mode of Search Pattern (such as 1500 ft AFE Approach to touchdown). The amount of time represented by an event frame can be as short as a single second (such as Center of Flight) or as long as the entire flight.

- Select the appropriate event frame in the active drop-down list. If using the **User Defined** category, select a routine event in each of the two drop-down lists.
- When finished, click the **>>** button or the **What to Look For** tab.
In the **Define New Module (What to Look For)** window (see Figure 6.10), click **Add Condition**.  

![Figure 6.10](image)

---

**Search Pattern (Simple Mode)**

**Details**
Add Existing Condition to New Module

Figure 6.11. Available Conditions Window

The Available Conditions window (see Figure 6.11), provides a list of all previously created parameter conditions. To add an existing condition to the module, simply click a condition in the list, and then click OK.
Notice that the added condition \(6.12a\) now appears in the Define New Module (What to Look For) window (see Figure 6.12).
Create New Condition

Figure 6.13. Define New Module (What To Look For) Window

To create a new condition, click **Add Condition** in the Define New Module (What to Look For) window (see Figure 6.13).
Position the cursor inside the **Available Conditions** window (see Figure 6.14), right-click, and then select **New**.

**Note:** Once a condition has been created, it cannot be deleted in the simple mode of Search Pattern. To delete a condition, use the advanced mode.

In the **Create New Condition** window (see Figure 6.15), perform the following steps:

- Select a parameter from the drop-down list. **Note:** Derived parameters are not available in the simple mode of Search Pattern. To create a new condition based on derived parameters, use the advanced mode.
- Select an operator from the drop-down list.
- Type a value into the text field.
• Click OK.  

Add Second Condition to New Module

Figure 6.16. Available Conditions Window

When adding a second condition to a module, the analyst is required to join them by setting the condition logic. To add a second condition to the module, select the condition in the list and click OK in the Available Conditions window (see Figure 6.16).

Figure 6.17. Set Condition Logic Window

The Set Condition Logic window (see Figure 6.17) appears only when a second condition has been added. Even though multiple conditions can be added to a module, the module logic is selected only one time. Click AND to require that all of the module conditions exist in order to
generate a query match. Click **OR** order to generate a query match.

### Save New Module

Figure 6.18. Define New Module (What To Look For) Window

Selected conditions and logic will appear in the display area of the **Define New Module (What to Look For)** window (see Figure 6.18). When all conditions have been added, click **Done.**
In the Pattern Wizard window (see Figure 6.19), the new module now appears in the Available Modules list box. The module now can be added to a pattern, as described previously in Section 6.2.1, Create New Pattern.

Note: Once a module has been created, it cannot be edited in the simple mode of Search Pattern. To edit a module, use the advanced mode of Search Pattern.

6.2.3. Run New Pattern Query

Analysts can query the APMS database to find flights that match a pattern. To run a new pattern query, click Run Pattern in the Search Pattern window (see Figure 6.20).
In the Run Search Pattern window (see Figure 6.21), perform the following steps:

- Select the appropriate fleet in the Fleets list box.
- Select the beginning month and year of the query in the Begin Date drop-down lists.
- Select the ending month and year of the query in the End Date drop-down lists.
- Select the appropriate tail number(s) in the Available Tail Numbers list.
  Note: To select multiple tail numbers, hold down the CTRL key and click the desired items. To quickly select a contiguous block of tail numbers, hold down the SHIFT key and click the first and last items in the block.
- Select flight origin(s) in the Origin list box.
  Note: To select multiple origins, hold down the CTRL key and click the desired items.
- Select flight destination(s) in the Destination list box.
  Note: To select multiple destinations, hold down the CTRL key and click the desired items.
By default, searches will locate only flight tail numbers that departed the selected origin airport(s) and arrived at the selected destination airport(s) during a single flight. To search for all tail numbers leaving the origin airport(s) regardless of destination(s), and all tail numbers arriving at the destination airport(s) regardless of origin airport(s), uncheck the **Flights Origin and Destination** checkbox.

- Select the appropriate pattern in the pattern list box.
- Click **Go**.

The **Search Pattern Progress** window (see Figure 6.22) tracks the query progress and identifies the flights matching the properties of the selected pattern.

The query results will appear when processing is complete. See Section 6.2.5, Interpret Pattern Results, to learn more about interpreting the results.
6.2.4. Open Existing Pattern Query

In addition to running new pattern queries, the analyst also can access the results of prior pattern queries. To open an existing query, click Pattern Results in the Search Pattern window (see Figure 6.23).

In the Run Patterns window (see Figure 6.24), select a pattern query, and then click View. The query results will appear immediately. See Section 6.2.5, Interpret Pattern Results, to learn more about interpreting the results.
6.2.5. Interpret Pattern Results

The Search Pattern window (see Figure 6.25) allows analysts to view a complete list of FFDs or SFFDs that match at least one module in the pattern. This window contains two tabbed pages: Pattern Results and Individual Results. These options are described below.

**Pattern Results**

![Figure 6.25. Search Pattern Window (Pattern Results Table)](image)

Analysts use the Pattern Results table (see Figure 6.25) to determine the flights they wish to examine in more detail. The Pattern Results table contains a row for every matching flight. Each row begins with the Flight column, which contains the flight’s unique FFD or SFFD number. The table also contains a separate column for every module associated with the applicable pattern. The numbers in these columns represent the time, in seconds, at which the module occurred during the flight. The RIN column contains an APMS-computed number that is displayed for every flight that matches a pattern. The RIN is the sum of the risk indices for the modules that occurred during a flight. A larger RIN indicates a greater risk. The RIN allows analysts to quickly sort the results based on the severity of the modules that occurred during a flight.

**Individual Results**

![Figure 6.26. Search Pattern Window (Individual Results Tab)](image)

The Individual Results table, (see Figure 6.26) summarizes each module that occurred in a specific flight. In addition to the information available in the Pattern Results table, the Individual
Results table contains a **Duration** column. This column lists the duration, in seconds, of a given module.

To obtain additional information about a flight, right-click on the appropriate record, then select **Flight Information**.

The **Flight Information** window (see Figure 6.27) provides summary information, *phases, special events, routine events,* and weather associated with the flight. The analyst also can use this window to access the **Viewer** or to obtain flight information from other FFDs or SFFDs. If research indicates that the events associated with a flight contain bad data, the analyst can use the **Set Bad Data** drop-down list in the **Summary** tab to mark the data as good or bad. The analyst can set data markers for a single flight or for all flights associated with an aircraft tail number.

**Note:** Flights that have been flagged with a bad data marker will not be used as baseline flights for computing atypicality. In other words, the Analysis Engine will not include these flights in an *aggregation* used to determine typical flight patterns.
7. Event Charts

7.1. Overview

The Event Charts tool displays report pages containing routine event charts for a selected group of flights. Each event chart is associated with one parameter and uses routine events to plot the parameter distributions. The charts contained on a report page allow an analyst to evaluate and compare parameter distributions at selected routine events within a group of flights.

Before generating and viewing report pages, the flight analyst must first create and define the following entities:


- **Page**: Category-specific container for charts. Defines the routine events, page title, and page layout for all associated charts. Sub-level directory of page group parent. Created and defined in the Page Manager box.

- **Chart**: Defines the parameter, chart style, chart title, and axis limits for a single chart. Sub-level directory of page parent. Created and defined in the Page Manager box.

- **Query Folder**: Category-specific container for queries. Parent directory in tree structure. Created in the Queries box.

- **Query**: Defines the query name, fleet(s), begin date, end date, tail number(s), origin airport(s), and destination airport(s) for a single query. Sub-level directory of query folder parent. Created and defined in the Queries box.
7.2. Details

7.2.1. Create Page Group

To create a page group, click the **Page Manager** tab in the **Event Charting** window (see Figure 7.1).
In the **Event Charting** window (see Figure 7.2), perform the following steps:

- Position the cursor inside the white area of the **Page Manager** box. **7.2a**
- Right-click the mouse. **7.2a**
- Click **Add Group** in the menu box. **7.2a**

In the **Page Group Name** window (see Figure 7.3), enter a name for the new page group in the text field **7.3a**, and then click **OK**. **7.3b**
To add a page to a page group, click the Page Manager tab in the Event Charting window (see Figure 7.4), and then perform the following steps:

- In the Page Manager box, click the page group that will contain the new page.  
- Right-click the mouse.  
- Click Add Page in the menu box.
In the **Page Properties** window (see Figure 7.5), perform the following steps:

- Enter a name for the new page in the **Page Name** text field.  
- Click on a pertinent routine event in the **Routine Events** list.  
- Click the > button.  
- Select additional routine events in the **Routine Events** list, as necessary.  
- When finished, click **OK**.
7.2.3. Add Chart to Page

To add a chart to a page, click the Page Manager tab in the Event Charting window (see Figure 7.6), and then perform the following steps:

- In the Page Manager box, click the page that will contain the new chart.
- Right-click the mouse.
- Click Add Chart in the menu box.
In the **Chart Properties** window (see Figure 7.7), perform the following steps:

- Enter a name for the new chart in the **Chart Title** text field.  
- Enter a display name for the new chart in the **Display Title** text field.  
- Select a chart type (spline or histogram) in the **Chart Type** drop-down list.  
- Select the appropriate parameter in the **Parameter Name** drop-down list.  
- Enter the appropriate values in the **Min Bin Value**, **Max Bin Value**, and **Bin Width** fields.  
  
  **Note:** When charting a parameter that is unfamiliar, simply make a rough estimate when first entering minimum and maximum bin values. If necessary, come back and adjust the values after viewing the chart.

- Click **Re-calculate Axis Labels**.
• To allow the creation of extra bins to collect flights with values less than the Min Bin Value and greater than the Max Bin Value, click the **Can Underflow** and **Can Overflow** boxes.

Note: When the **Can Underflow** and **Can Overflow** boxes are *not* checked, flights with values less than the Min Bin Value and greater than the Max Bin Value are placed in the nearest available bins.

• When finished, click **Save**.

### 7.2.4. Create Query

To create a query, click the **Queries** tab in the **Event Charting** window (see Figure 7.8).
In the Event Charting window (see Figure 7.9), perform the following steps:

- Position the cursor inside the white area of the Queries box. \(7.9a\)
- Right-click the mouse.
- Select Add Folder>Root Folder in the menu box. \(7.9b\)
In the Event Charting window (see Figure 7.10), perform the following steps:

- Click the newly created folder in the Queries box. **7.10a**
  
  Note: The query folder can be given a new name at any time. To do this, simply double-click on the folder title and enter an appropriate name.

- Right-click the mouse.

- Select Add Query in the menu box. **7.10b**
In the Flight Query Data Selection window (see Figure 7.11), perform the following steps:

- Enter a name for the new query in the **Query Name** text field.  
  ![Query Name](7.11a)

- Select the appropriate fleet in the **Fleet** list.  
  ![Fleet](7.11b)

- Select the appropriate starting month and year in the **Begin Date** drop-down lists.  
  ![Begin Date](7.11c)
  **Note:** By default, this date will reflect the earliest month for which there is data for the selected fleet.

- Select the appropriate ending month and year in the **End Date** drop-down lists.  
  ![End Date](7.11d)
  **Note:** By default, this date will reflect the latest month for which there is data for the selected fleet.

- Select the appropriate tail number(s) in the **Available Tail Numbers** list.  
  ![Available Tail Numbers](7.11e)
Note: To select multiple tail numbers, hold down the CTRL key and click the desired items. To quickly select a contiguous block of tail numbers, hold down the SHIFT key and click the first and last items in the block. To quickly select all tail numbers, click the Select All Tail Numbers box.

- Select the appropriate origin airport(s) in the Origin list.  
  Note: To select multiple origin airports, hold down the CTRL key and click the desired items. To quickly select all airports, click the Select All box.
- Select the appropriate destination airport(s) in the Destination.  
  Note: To select multiple destination airports, hold down the CTRL key and click the desired items. To quickly select all airports, click the Select All box.
- To include only those flights that departed one of the selected origin airports and also arrived at one of the selected destination airports during a single flight, check the Flight Origin and Destination Airports Must Match Selection box.  
  Note: If this box is not checked, origin and destination will be uncoupled. In other words, the query will include all flights leaving the origin airport(s), regardless of destination. It also will include all flights arriving at the destination airport(s), regardless of origin.
- When finished, click OK.  

7.2.5. Run Report

Figure 7.12. Event Charting Window
To run a report and view charts, click the Page Manager tab in the Event Charting window (see Figure 7.12).

Figure 7.13. Event Charting Window

In the Event Charting window (see Figure 7.13), perform the following steps:

- Click the thumbnail icon in the Page Manager box.  
  Note: The thumbnail icon should now be pointing down to indicate that the Page Manager box is locked on the page.
- Click the Queries tab.
- Click the thumbnail icon in the Queries box.
In the Event Charting window (see Figure 7.14), perform the following steps:

- In the Queries box, check the tick box beside the folders (to include all queries in the folders) or individual queries to be included in the report.

- In the Page Manager box, click the appropriate page group (to include all existing charts for every page in the group), page (to include all existing charts for that page), or individual chart to be displayed.

- Click the thumbnail icon in the Queries box to dock the box.

- Click the thumbnail icon in the Page Manager box to dock the box.

  **Note:** Docking the Queries and Page Manager boxes leaves more room to render the charts.

- Click Run Report.
7.2.6. View Charts

In the Event Charting window (see Figure 7.15), choose any of the following options:

- To export chart(s), select File>Export>PowerPoint or File>Export>Excel in the menu.  

- To zoom in on a single chart, right-click inside the chart and then select Zoom Chart.  
  Note: This feature operates as a toggle. To return to the default view, simply click Zoom Chart again.

- To produce separate charts for each routine event, right-click inside the chart and then select Split Chart in the menu box.
To produce a list of all flights occupying a specific data point, right-click on the data point and then select Chart Data>Flights in Data Exploration in the menu box.

To produce a table that contains the total number of flights in each bin for every routine event, right-click inside the chart and then select Chart Data>Raw Data Counts in the menu box.

To quickly edit the properties of a chart, click on the appropriate chart and then select Edit Chart in the menu box.
8. Flight Validation

8.1. Overview

The Flight Validation tool allows a flight analyst to view all *special events*, *routine events*, and *atypicalities* associated with a flight and to *validate* or *invalidate* the record based on additional research. The analyst can filter the results to view only records with specific characteristics. After researching an event or atypicality, the analyst can produce a validation form and select the appropriate validation status.

8.2. Details

8.2.1. Select Fleet

Figure 8.1. Flight Validation Window
The flight analyst first must select a fleet in the **Flight Validation** window (see Figure 8.1). To do this, select a fleet in the **Fleet** drop-down list, and then click **Refresh Flight List**.

### 8.2.2. View Flight List

**Figure 8.2. Flight Validation Window**

Once a fleet is selected, the **Flight List** box is populated with summary flight information in the **Flight Validation** window (see Figure 8.2). To search for a specific flight that is not visible, click **Page Down**.
8.2.3. Filter Flight List

Analysts can filter the flight list to display only those records that match specific categories. By marking the check boxes next to Actions, Levels, and Status in the Flight Validation window (see Figure 8.3), the drop-down lists are enabled (see Figure 8.4).

The Actions list allows the analyst to restrict the view to only records coded with a particular action item (such as Investigation or Maintenance). The options in this list correspond with the actions options available in the Validation window (see Figure 8.11). (The Validation window is described in greater detail in Section 8.2.7, Validate Selection.)

The Levels list allows the analyst to restrict the view to only records that contain special events and atypicalities at or above the selected level. For example, to restrict the view to only mid-severity Level 2 items and high-severity Level 3 items, select 2.

Note: Level 0 items are low-priority special events identified by SAGEM Avionics, a company that preprocesses digital flight data.

The Status list allows the analyst to restrict the view to only records coded with a particular validation status (such as Confirmed or Pending). The status options in this list also
correspond with the validation status options available in the Validation window (see Figure 8.11). (The Validation window is described in greater detail in Section 8.2.7, Validate Selection.)

8.2.4. Select Flight

Figure 8.5. Flight Validation Window

In the Flight Validation window (see Figure 8.5), click on a flight to select it in the Flight List box. After a flight has been selected, all associated special events will appear in the Special Events table, and all associated atypicalities will appear in the Analysis List table. These tables are described below.
8.2.5. View Special Events & Routine Events

The **Special Events** table (see Figure 8.6) displays event status, event description, event level, event time in flight, flight *phase*, and event duration for every special event associated with the flight.

To view the flight's routine events, click the **Routine Events** tab.

The **Routine Events** table (see Figure 8.7) displays the event time for the flight's routine events. This allows an analyst to reference special events to the time of routine events in a flight.
8.2.6. View Analysis List & Analysis Details

Figure 8.8. Analysis List Table (Flight Validation Window)

<table>
<thead>
<tr>
<th>Analysis List</th>
<th>Analysis Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Status</td>
</tr>
<tr>
<td>3</td>
<td>Pending</td>
</tr>
<tr>
<td>3</td>
<td>Pending</td>
</tr>
<tr>
<td>3</td>
<td>Pending</td>
</tr>
<tr>
<td>3</td>
<td>Pending</td>
</tr>
</tbody>
</table>

The Analysis List tab (see Figure 8.8) displays the global atypicality level, atypicality analysis status, analysis date, and event level for every phase atypicality associated with the flight.

To view the details associated with an atypicality, select the appropriate record, and then click the Analysis Details tab.

Figure 8.9. Analysis Details Table (Flight Validation Window)

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Rationale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevator_Pos_L</td>
<td>average value is more nose down than normal</td>
</tr>
<tr>
<td>Acc_Vrt</td>
<td>average slope is less negative than normal</td>
</tr>
<tr>
<td>Fuel_Flow_Cor_I</td>
<td>minimum value is lower than normal</td>
</tr>
</tbody>
</table>

The Analysis Details table (see Figure 8.9) displays parameter names and rationale descriptions for every atypicality associated with the flight.
8.2.7. Validate Selection

Analysts can use the Viewer tool to perform additional research on special events and atypicalities. To open the Viewer from the Flight Validation window (see Figure 8.10), simply select a flight in the Flight List box, then click Send to Viewer.

Once the analyst has sufficiently researched a flight, it’s time to assign the proper validation status to every special event and atypicality. To do this, simply double-click the special event or atypicality item in the appropriate table, or select the special event or atypicality and click the corresponding Validate Event or Validate Analysis button.

---

**Table:**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Level</th>
<th>Time in Flight</th>
<th>Phase Name</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>High Alt Flight</td>
<td>1</td>
<td>645</td>
<td>Takeoff</td>
<td>0</td>
</tr>
<tr>
<td>Pending</td>
<td>Descent Rate Hi</td>
<td>1</td>
<td>4915</td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

**Figure 8.10. Flight Validation Window**

![Flight Validation Window](image)

**Diagram:**

1. Analysts can use the Viewer tool to perform additional research on special events and atypicalities.
2. To open the Viewer from the Flight Validation window, select a flight in the Flight List box and click Send to Viewer.
3. Once research is complete, assign the proper validation status to every special event and atypicality. This can be done by double-clicking the item in the table or selecting it and clicking the Validate Event or Validate Analysis button.
In the Validation window (see Figure 8.11), select one of the following options in the Validation Status box:

- **Validation Deferred**: Record status is uncertain and will be revisited.
- **Validation Pending**: Record has not been reviewed.
- **Validated**: Record is valid with a confirmed or exempted disposition.
- **Invalidated**: Record contains bad data, or the special event or atypicality has been badly defined.
- **Refer For Second Opinion**: Event or analysis will be flagged so that it can be recalled and evaluated later by a second analyst.

In addition, analysts can select one or both of the following choices in the Actions box:
- **Maintenance**: Maintenance is needed on the aircraft associated with this flight.
- **Investigation**: An investigation needs to be performed for this event.

To add comments to a validation record, simply enter text into the empty field, and then click **Add New Comment**. The comment will appear in the **Comments** box. The user name and date of entry will be added automatically to the record.

When all the information has been entered for the validation record, click **Save and Close** to save the validation record and exit the **Validation** window.

The validated record now will be updated in the **Flight Validation** window (see Figure 8.12). Note that **Status** column in the **Analysis List** table has been updated to “Confirmed” status, and that the comment box also has been updated.
9. Reports

9.1. Overview

The Reports tool allows analysts to create custom graphs and statistics tables from flight data. Users first build templates, and then create reports based on the templates. The Reports tool actually consists of two separate tools that use a similar design:

- The Performance Report tool generates reports from parameter data in the Full Flight Data (FFD) or Scrubbed Full Flight Data (SFFD) file. Analysts group flights by phase (or segment), fleet, date, and airport. Graph outputs include bar charts, line charts, area charts, and histograms. Analysts use this tool to determine the overall pattern of performance for an entire group of flights.

  Note: At this time, the Performance Report tool plots only distance data on the x-axis. For this reason, the tool is most useful for analyses of takeoffs and landings.

- The Special Event Report tool generates reports from a flat file of special events, or exceedances. Analysts use this tool to evaluate the numbers and rates of special events and to make comparisons with other flights.

The Performance Report and Special Event Report tools will be described separately, with an introductory section that describes set-up details common to both tools.
9.2. Set-up Details

9.2.1. Log In

Unlike other APMS tools, the Reports tool opens with its own Login window (see Figure 9.1). Simply type the appropriate information into the User Name and Password fields, and then click Login.

Note: A user name and password will be provided by the system administrator.
9.2.2. Create User Category

Analysts must create a user category before beginning work in either the Performance Reports tool or the Special Events report. To create a user category, click Manage Categories in the Reports Home Page window (see Figure 9.2).
In the Report Categories window (see Figure 9.3), type a user name in the Name field and select a permissions level from the Permission drop-down box. Click Add to create the user category.
9.3. Performance Report Details

  9.3.1. Create New Template

Analysts first build templates, and then create performance reports based on the templates. Performance report templates define the specific flight phase (or segment) to be analyzed. They also allow the analyst to define the type of output (such as a bar chart or histogram) for a report. To create a template, click Create Templates in the left-side menu of the Reports Home Page window (see Figure 9.4).
In the **Create Performance Report Templates** window (see Figure 9.5), follow these steps to create a template:

- Type a name for the template in the **Template Name** field.  
- Select the appropriate user category in the **Template Category** drop-down list.  
- Select the desired flight phase (or segment) to analyze in the **Report Type** drop-down list.  
- Select the desired graph type in the **Graph Type** drop-down list.  
- To overwrite the default routine event marking the start of selected phase, select a new routine event in the **Starting Marker** drop-down list.  
- To overwrite the default routine event marking the end of selected phase, select a new routine event in the **Ending Marker** drop-down list.
- Click Add Segment to add a phase to the template. The phase should appear in the Report Segments box.
- If desired, add additional phases to the template.
- When finished, click Create Template. The new template should appear in the template list at the bottom of the page.

Note: Templates can be edited for future revision.

9.3.2. Create New Report

Figure 9.6. Create Performance Reports Window
A performance report can be built on any template that is available in the **Create Performance Reports** window (see Figure 9.6). To create a report, follow these steps:

- Click **Select** for the appropriate template in the **Report Template** list.  
- Type a name for the report in the **Report Name** field.  
- Select the appropriate user category in the **Report Category** drop-down list.  
- Select arriving flights, departing flights, or all flights in the **Operation** drop-down list.  
- Select the appropriate fleet in the **Fleet** drop-down list.  
- Select one or more airports in the **Airports** scroll list.  
- Select the start date in the **Starting Date** calendar.  
- Select the end date in the **Ending Date** calendar.  
- When finished, click **Run Now**.  

**Note:** Reports cannot be edited once they have been created.
9.3.3. View Report

Figure 9.7. Performance Report Window

The report results will appear in the Performance Report window (see Figure 9.7). Click Add to PowerPoint (9.7a) to automatically load selected charts into a PowerPoint document. Click Discard (9.7b) to remove the entire report from the reports archive.

To view additional report details, click View Reports. (9.7c)
The View Performance Reports window (see Figure 9.8) displays a list of all saved reports. To view all details of a report, click Select for the appropriate report, and then click Report Details.

Note: To create a zipped file containing graphics, statistics, and XML files for this report, simply click Download.
The **View Performance Report Details** window (see Figure 9.9) allows the analyst to view all details of a report. To view a graph that combines the plots from two or more charts, click **Combined**. To view XML data for the report, click **XML File**. To view a statistics table, click **Statistics**.
9.4. Special Event Report Details

9.4.1. Create New Template

Analysts first build templates, and then create special event reports based on the templates. Special event report templates define the specific events and phases to be analyzed. They also allow the analyst to chart the output by event, status, airport, month, or year. To create a template, click **Create Templates** in the left-side menu of the Reports Home Page window (see Figure 9.10).
In the Create Special Event Report Templates window (see Figure 9.11), follow these steps to create a template:

- Type a name for the template in the **Name** field.
- Select the appropriate user category in the **Category** drop-down list.
- Select the desired measuring unit (counts or rate) for the x-axis in the **Measure** drop-down list.
- Select the desired chart type (line or bar) in the **Format** drop-down list.
- Select the data category (event, airport, status, month, or year) for the y-axis in the **Charted by** drop-down list.
- Select the desired number of items to chart for the y-axis category in the **Top Items** drop-down list. For example, if the data category in the **Charted by** list is Airport, a selection of 5 in the **Top Items** list will chart results for the five most active airports.
Select the data category (individual event, individual airport, individual status, individual month, individual year, total events, or total airports) in the **Separated by** drop-down list. For example, select Individual Month to produce a separate chart for each month.

Select the desired event levels (all, levels 2 and 3 only, or level 3 only) in the **Event Levels** drop-down list.

Select any or all events in the **Events** drop-down list.

Select any or all phases in the **Phases** drop-down list.

When finished, click **Add**. The new template should appear in the template list at the bottom of the page.

**Note:** Templates can be edited for future revision.
9.4.2. Create New Report

Figure 9.12. Create Special Event Reports Window

Create Special Event Reports

Filter templates by category: No Filter

Report Templates

Report Name: Separated by Mile

Report Category: Tested 1

Comments:

Fleet:

Operation: All

Filter by Search Pattern: NOFILTER

[Whole Database (all available dates)]

Starting Date: February 2004

Ending Date: March 2004

Airports:
A special event report can be built on any template that is available in the **Create Special Event Reports** window (see Figure 9.12). To create a report, follow these steps:

- Click **Select** for the appropriate template in the **Report Templates** list.  
- Type a name for the report in the **Report Name** field.  
- Select the appropriate user category in the **Report Category** drop-down list.  
- Select the appropriate fleet in the **Fleet** drop-down list.  
- Select arriving flights, departing flights, or all flights in the **Operation** drop-down list.  
- Select one or more airports in the **Airports** scroll list.  
- Select the start date in the **Starting Date** calendar.  
- Select the end date in the **Ending Date** calendar.  
- When finished, click **Create**.  

**Note:** Reports cannot be edited once they have been created.
9.4.3. View Report

The report results will appear in the Special Event Report window (see Figure 9.13). Click Add to PowerPoint to automatically load selected charts into a PowerPoint document. Click Discard to remove the entire report from the reports archive.

To view additional report details, click View Reports.
The View Special Event Reports window (see Figure 9.14) displays a list of all saved reports. To view all details of a report, click Select for the appropriate report, and then click Report Details.

Note: To create a zipped file containing graphics, statistics, and XML files for this report, simply click Download.
The View Special Event Report Details window (see Figure 9.15) allows the analyst to view all details of a report. To view the next graph in the series, click Next. To add the visible chart to a new or existing PowerPoint document, click Add to PowerPoint. To view template and report criteria, click Show Graph Info. To view a statistics table, click Statistics. To add the entire report to a new or existing PowerPoint document, click Add Report to PowerPoint.
### 10. Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>A group of new and existing flights (typically totaling 1,000) used by the Analysis Engine to produce an analysis report. Flights from the same fleet (and, if applicable, from the same originating or destination airport) are grouped to form an aggregation. The Analysis Engine then compares the flights by phase to determine the most atypical flights in the aggregation.</td>
</tr>
<tr>
<td>Analysis Engine Tool</td>
<td>An APMS utility that uses internal algorithms to identify typical patterns and atypical flights represented in bodies of digital flight data. Because it operates without any prior human specification of normal or operationally interesting flight patterns, the Analysis Engine can reveal unexpected events or trends that could compromise the safety of flight operations. This utility produces the analysis reports used by the Morning Report tool.</td>
</tr>
<tr>
<td>Analysis Report</td>
<td>A report generated either manually or automatically by an APMS utility called the Analysis Engine. This report identifies atypical flights and atypical flight phases. It is displayed by the Morning Report tool.</td>
</tr>
<tr>
<td>APMS</td>
<td>NASA’s Aviation Performance Measuring System.</td>
</tr>
<tr>
<td>Atypicality</td>
<td>An anomaly in the digital flight data for a specific flight or phase of a flight. The Morning Report tool is used to view the atypicalities identified by the Analysis Engine utility.</td>
</tr>
<tr>
<td>Cartridge</td>
<td>A removable disc that stores digital flight data. A cartridge usually contains data from multiple flights of a single aircraft. Cartridges are identified by aircraft tail number and date of last recorded data.</td>
</tr>
<tr>
<td>Data Exploration Tool</td>
<td>An APMS tool that allows analysts to conduct in-depth research on a flight. It contains links to other tools and utilities, including the Viewer, Parameter Editor, and Loader.</td>
</tr>
<tr>
<td>Derived Parameter</td>
<td>A custom parameter that is defined by the user and generated within APMS. A derived parameter is frequently based on a mathematical equation and the values from other flight parameters. For example, an aircraft’s potential energy can be derived at any given moment of the flight by multiplying its gross weight parameter value by its altitude parameter value.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event Charts Tool</td>
<td>An APMS tool that report pages containing routine event charts for a selected group of flights. Each event chart is associated with one parameter and uses routine events to plot the parameter’s distributions. The charts contained in a report page allow an analyst to evaluate and compare parameter distributions at routine events within a group of flights.</td>
</tr>
<tr>
<td>Event Frame</td>
<td>A selected moment or span of time in a flight. An event frame can be an APMS-defined phase (such as Cruise), a user-defined time period based on routine event markers (such as Taxi Out to Liftoff), or a custom time period created in the advanced mode of Search Pattern (such as 1500 ft AFE Approach to Touchdown). The time represented by an event frame can be as short as a single second or as long as the entire flight.</td>
</tr>
<tr>
<td>Exceedance</td>
<td>See Special Event.</td>
</tr>
<tr>
<td>FFD File</td>
<td>Full Flight Data file. A complete set of flight data for a single flight. This unfiltered file contains all parameter values from takeoff to touchdown. The APMS Loader utility creates a separate FFD file for each flight while importing raw flight data.</td>
</tr>
<tr>
<td>Fleet Editor Utility</td>
<td>An APMS data importation utility. For more information, see the APMS 3.0 System Administrator’s Guide.</td>
</tr>
<tr>
<td>Flight Validation Tool</td>
<td>An APMS tool that allows a flight analyst to view all special events, routine events, and atypicalities associated with a flight and to affirm or invalidate the record.</td>
</tr>
<tr>
<td>FOQA</td>
<td>Flight Operational Quality Assurance team. These aviation-safety analysts review data recorded during flight to improve the safety of flight operations, air traffic control procedures, and airport and aircraft design and maintenance.</td>
</tr>
<tr>
<td>Generic Parameter Name</td>
<td>A parameter that has been given a standardized name within APMS. Prior to importation to APMS, digital flight data contain parameter names that vary depending on the particular airline, fleet, or recording device. APMS programmers assign a common parameter name to each parameter to enable cross-fleet analyses. Generic parameter names are for internal APMS use only.</td>
</tr>
<tr>
<td>Global Atypicality</td>
<td>An anomaly in the digital flight data associated with a specific flight. A flight with global atypicality contains one or more phases with parameters that vary from those of other related flights. The Analysis Engine utility identifies flights with global atypicality and ranks the degree of variance. A flight can have only one global atypicality ranking per analysis report. Analysts use the Morning Report tool to identify flights with global atypicality.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GRADE</td>
<td>Graphical Airspace Design Environment. GRADE, developed by ATAC Corp., is a PC-based, four-dimensional computer tool for displaying, analyzing, designing, and evaluating air traffic operations. The Viewer and Data Exploration tools contain a link to the GRADE system.</td>
</tr>
<tr>
<td>Invalidated Atypicality</td>
<td>An atypicality that has been rejected and flagged as invalid by a flight analyst. This designation usually indicates that the atypicality resulted from bad data.</td>
</tr>
<tr>
<td>Invalidated Special Event</td>
<td>A special event that has been rejected and flagged as invalid by a flight analyst. This designation usually indicates that the special event resulted from bad data.</td>
</tr>
<tr>
<td>Level 1 Atypicality</td>
<td>An atypical flight or phase with parameters that vary slightly from those of other related flights in an aggregation. The level is assigned by the Analysis Engine utility.</td>
</tr>
<tr>
<td>Level 2 Atypicality</td>
<td>An atypical flight or phase with parameters that vary moderately from those of other related flights in an aggregation. The level is assigned by the Analysis Engine utility.</td>
</tr>
<tr>
<td>Level 3 Atypicality</td>
<td>An atypical flight or phase with parameters that vary greatly from those of other related flights in an aggregation. The level is assigned by the Analysis Engine utility.</td>
</tr>
<tr>
<td>Level 1 Special Event</td>
<td>A special event that presents a low risk to aviation safety. The level is assigned by commercial flight data processing software prior to data importation by APMS.</td>
</tr>
<tr>
<td>Level 2 Special Event</td>
<td>A special event that presents a medium risk to aviation safety. The level is assigned by commercial flight data processing software prior to data importation by APMS.</td>
</tr>
<tr>
<td>Level 3 Special Event</td>
<td>A special event that presents a high risk to aviation safety. The level is assigned by commercial flight data processing software prior to data importation by APMS.</td>
</tr>
<tr>
<td>Loader Utility</td>
<td>An APMS data importation utility that is used to access the online data stores generated by commercial flight data processing software. For more information, see the APMS 3.0 System Administrator’s Guide.</td>
</tr>
<tr>
<td>Module</td>
<td>A user-defined flight event composed of one or more parameter conditions (such as N1_Eng_1_corr ≤ 45), applied to a specific time frame (such as Ten Minutes before Touchdown). One or more modules define a pattern. (This term applies only to the Search Pattern tool.)</td>
</tr>
<tr>
<td><strong>Term</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Morning Report Tool</td>
<td>An APMS tool that provides textual descriptions and graphical representations of data imported from the Analysis Engine’s reports. This tool allows analysts to study selected groupings of flights and to investigate flight and phase atypicalities.</td>
</tr>
<tr>
<td>Parameter</td>
<td>A sensor-monitored flight condition, such as average fuel burned per hour. Digital flight data recorders are used to register and store a numerical value for each parameter every second or fraction of a second throughout the flight. Hundreds, or even thousands, of parameters can be collected for a single flight. Some parameters relate to continuous data (such as altitude and airspeed). Other parameters assume just two, or a few, discrete values (such as the on or off position of the thrust reverser).</td>
</tr>
<tr>
<td>Parameter Cloud</td>
<td>In the Morning Report display, a graphical representation of data from an aggregation of flights. The parameter cloud depicts the range of digitally recorded values for a single parameter during a specific phase. This graphical visualization provides a frame of reference against which the parameter trace from a single atypical flight can be overlaid and visually assessed by human analysts.</td>
</tr>
<tr>
<td>Parameter Condition</td>
<td>A user-defined equation that includes a specific flight parameter, an operator, and a numeric value (for example, Airspd_Computed ≥ 200). One or more parameter conditions, when applied to a specific event frame, define a module. (This term applies only to the Search Pattern tool.)</td>
</tr>
<tr>
<td>Parameter Display Name</td>
<td>The parameter name that appears in the APMS tools used by flight analysts. Unlike a generic parameter name that is used only by APMS programmers, a display name is usually more meaningful to end-users and can be modified to allow individual airlines to adopt their own terminology.</td>
</tr>
<tr>
<td>Parameter Editor Utility</td>
<td>An APMS data importation utility. For more information, see the APMS 3.0 System Administrator’s Guide.</td>
</tr>
<tr>
<td>Parameter Trace</td>
<td>In the Morning Report, a graphical representation of data from a single flight depicting the digitally recorded values for a single parameter during a specific phase. The trace appears as a black line.</td>
</tr>
<tr>
<td>Pattern</td>
<td>A user-defined data map that is used to locate flights that share specific characteristics. Each pattern consists of one or more modules, or user-defined flight events. (This term applies only to the Search Pattern tool.)</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Performance Report</td>
<td>One of two Reports tools. The Performance Report tool generates reports from parameter data in the Full Flight Data (FFD) or Scrubbed Full Flight Data (SFFD) file. Graph outputs include bar charts, line charts, area charts, and histograms. Analysts use this tool to determine the overall pattern of performance for an entire group of flights. See Reports Tool.</td>
</tr>
<tr>
<td>Phase</td>
<td>A distinct segment of a flight (such as Begin Cruise or Final Approach) that is defined by the routine event markers that precede and follow it.</td>
</tr>
<tr>
<td>Phase Atypicality</td>
<td>An anomaly in the digital flight data associated with a specific phase of a flight. A flight with phase atypicality contains parameters that vary to a significant degree from those of other related flights. The Analysis Engine utility identifies flights with phase atypicality and ranks the degree of variance. A single flight can have a different phase atypicality ranking for each atypical phase. Analysts use the Morning Report tool to display flights with phase atypicality. Analysts use the Flight Validation tool to confirm or reject the anomaly.</td>
</tr>
<tr>
<td>Phase Editor Utility</td>
<td>An APMS data importation utility. For more information, see the APMS 3.0 System Administrator’s Guide.</td>
</tr>
<tr>
<td>Reports Tools</td>
<td>A pair of APMS tools that allow analysts to create custom graphs and statistics tables from flight data. The Reports tools consist of the Performance Report tool and the Special Event Report tool. The Performance Tool generates reports from parameter data in the Full Flight Data (FFD) or Scrubbed Full Flight Data (SFFD) file. The Special Event Report tool generates reports from a flat file of special events, or undesirable flight occurrences. See Performance Report Tool and Special Event Report Tool.</td>
</tr>
<tr>
<td>RIN</td>
<td>An APMS-computed number that is displayed for every flight that matches a pattern. The RIN is the sum of the module risk indices that occurred during a flight. The larger the RIN, the greater the risk. The RIN allows analysts to locate the most critical flights that appear in search pattern results. (This term applies only to the Search Pattern tool.)</td>
</tr>
<tr>
<td>Risk Index</td>
<td>An analyst-assigned risk level for each module in a pattern. This numerical value allows analysts to weight the relative degree of risk from the combined parameter conditions included in the module. The larger the number, the greater the risk. The risk index is used to compute the RIN for every flight that matches a pattern. Currently, there is no default risk index value range in APMS.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Routine Event</td>
<td>A regular flight occurrence (such as Liftoff) that can be identified by its unique data signature. A routine event occurs when an individual flight parameter (such as air speed, pitch angle, or average fuel burned per hour) or combinations of individual flight parameters reach a predetermined value or range of values. The APMS Loader utility uses pattern search definitions to find and mark routine events in the FFD file while importing raw flight data.</td>
</tr>
<tr>
<td>Search Pattern Tool</td>
<td>An APMS tool that is used to search FFD or SFFD files for patterns in flight data. The Search Pattern tool allows a flight analyst to define flight patterns and use them to query matching flights in the APMS database.</td>
</tr>
<tr>
<td>SFFD</td>
<td>Scrubbed Full Flight Data file. An SFFD is a filtered version of the original FFD file.</td>
</tr>
<tr>
<td>Special Event</td>
<td>A predefined and undesirable flight occurrence (such as Low Power on Approach) that results from operational anomalies. A special event, also known as an exceedance, occurs when an individual flight parameter (such as air speed, pitch angle, or average fuel burned per hour) or combination of parameters exceeds a predetermined, fleet-specific value or range of values. Commercial flight data processing software is used to identify and record special events prior to data importation by APMS.</td>
</tr>
<tr>
<td>Special Event Report</td>
<td>One of two Reports tools. The Special Event Report tool generates reports from a flat file of special events, or undesirable flight occurrences. Analysts use this tool to evaluate the numbers and rates of special events and to make comparisons with other flights. See Reports Tool.</td>
</tr>
<tr>
<td>Validated Atypicality</td>
<td>A phase atypicality that has been confirmed and flagged as valid by a flight analyst. This designation usually indicates that the atypicality is legitimate and did not result from bad data.</td>
</tr>
<tr>
<td>Validated Special Event</td>
<td>A special event that has been confirmed and flagged as valid by a flight analyst. This designation usually indicates that the special event is legitimate and did not result from bad data.</td>
</tr>
</tbody>
</table>

Glossary Page 104 of 104

Revision: 0.5.1
The Aviation Performance Measuring System (APMS) is a method—embodied in software—that uses mathematical algorithms and related procedures to analyze digital flight data extracted from aircraft flight data recorders.

APMS consists of an integrated set of tools used to perform two primary functions:

- Flight Data Importation
- Flight Data Analysis.

<table>
<thead>
<tr>
<th>13. ABSTRACT (Maximum 200 words)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Aviation Performance Measuring System (APMS) is a method—embodied in software—that uses mathematical algorithms and related procedures to analyze digital flight data extracted from aircraft flight data recorders. APMS consists of an integrated set of tools used to perform two primary functions:</td>
</tr>
<tr>
<td>Flight Data Importation</td>
</tr>
<tr>
<td>Flight Data Analysis.</td>
</tr>
</tbody>
</table>